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**Introduction: 

Thank you for downloading the StarCast Recorder.  This guide will help familiarize you with how to get the most 
out of the StarCast Recorder, hereafter referred to as SCR.  The general purpose of the SCR is to help you prepare 
course material for use in the StarCast System.  This course material is managed, scheduled, assigned, reviewed, 
and so forth from the StarCast Administration website.  Your employees, customers, partners and other users will 
view this course material using the StarCast Player, which is launched from within the StarCast website or from 
Rocketmails.  As a user of SCR, your role is likely as a Knowledge Expert, a Voice Talent, a Training 
Administrator, or some combination thereof; within the StarCast System you are referred to as a Content Manager. 
The general workflow tends to follow this pattern: 

1) A Knowledge Expert creates (or modifies) a MicroSoft PowerPoint Presentation relating to the subject matter at 
hand. 
2) A Knowledge Expert writes a script or an outline for the narration that will accompany this presentation. 
3) A Voice Talent records the narration, editing and re-recording until satisfied. 
4) A Knowledge Expert optionally adds animations or embeds other training videos to enhance the visual impact of 
the training material. 
5) A Training Administrator publishes these materials to the StarCast System, whereupon they are converted for 
playback through an ordinary web browser. 
6) Stakeholders review and refine the material, repeating steps as necessary. 
7) Distributing, Assigning, and Tracking the use of your StarCast Presentations is covered in the appropriate guide. 

Note that in a great many cases, all three roles will be performed by the same person. 

**System Requirements 

The StarCast Recorder requires 

1) Windows XP or newer (+) 
2) Internet Explorer 7 or 8 
3) Microsoft PowerPoint 2000 or newer 
4) Any computer made this decade with at least 256 MB of RAM 
5) A Microphone and Speakers 

(+)At this time, there is not a Mac OS X nor a Linux version available.  However, StarCast is always evaluating our 
customers' needs and we reevaluate our platform support from time to time.  However, SCR works well with many 
Windows solutions for these platforms, such as CrossOver or Parallels. 

**A Quick note about WebCasting
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In StarCast, WebCasts do not use your audio recorded in SCR, as a WebCast is a live event.  Only the Embedded 
Video and Publishing sections are relevant for WebCasts.  However, when you Publish your presentation, WebCast 
and WebCourse versions are always prepared, even if you only intend to use one of them.  If you do not record any 
audio for a given slide, 10 seconds of silence will be added (or enough time for the animations to play, whichever is 
greateer) to the WebCourse version.

**Setting Up 

Getting up and running with SCR is very easy.  You will need to have a microphone and speakers for your 
computer, and we recommend using a USB microphone, as these days most computers make it very easy to plug in 
USB devices.  Also, many Bluetooth headsets (for cellphones) are recognized automatically as well.  StarCast does 
not, however, provide technical support in configuring your computer hardware; instead, if you need assistance in 
this area contact your IT support person (if you have one) or contact whomever you purchased your computer from. 

Often times, your computer will think that you have more than one place that sound can come from; for example, 
your computer might recognize a soundcard, a WebCam, a dedicated microphone, and a Bluetooth headset all at the 
same time!  We recommend that you go to the "Sounds and Audio Devices" section of the Windows Control Panel 
and double check which device is selected for input. 

Finally, you will want to find a relatively quiet place to do your recording.  If at all possible, turn off fans, air 
conditioners, and other noisy computers, and put your cellphone on vibrate.  Then, you will want to speak as 
directly into the microphone as you can, so that you record more of your voice and less room noise.  Also, most 
microphones offer an adjustable recording volume; from within SCR, select "Edit->Properties" from the menu, and 
you can adjust your recording and output volumes.  You will want to adjust your recording volume so that you get a 
strong signal without distorting the sound.  If you find the blue waveform crashing into the top or bottom an 
excessive amount, you may need to turn down your recording volume. 

**Preparing Your PowerPoint 

Having a quality presentation is the first step in making good StarCast Training.  There are, however, a few things 
you should know.  In particular, PowerPoint is the starting point from which you will prepare your StarCast 
Training.  At StarCast, we strive to make the transition from PPT as seamless as possible, but you shouldn't expect a 
100% perfect translation from PowerPoint into StarCast.  Please check our online help for Supported Animations 
and other tips and tricks  that we have for getting your presentations to look their best.  Most of our customers find 
that only small changes are ever needed, but we like to stress that you should ALWAYS review your presentations 
after publishing, and it is unwise to wait until 5 minutes before your big meeting to publish! 

**Opening the StarCast Recorder and working with PowerPoint 

SCR works hand in hand with Microsoft PowerPoint, which must already be installed on your computer (version 
2000 or later).  You must at all times have a presentation open while SCR is open, although you may switch 
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between presentations as you see fit.  When you first open SCR, it will recognize any PPT you already have open 
and you can get right to work.  If you don't have a PPT open, SCR will open a generic StarCast presentation.  You 
should note, however, that this generic presentation is Read Only and cannot be modified.  If you are working on a 
new presentation, you will want to save it and give it a name before you begin recording with SCR, as all of your 
recordings go in a directory with the same name as your PPT with "-audio" appended (all of your recordings in this 
folder are stored using the open Ogg Vorbis format to conserve your disk space; visit  HYPERLINK "http://
www.xiph.org" www.xiph.org or  HYPERLINK "http://www.vorbis.com" www.vorbis.com for more information). 

However, SCR and PowerPoint are two separate applications, and SCR cannot know about actions that you perform 
while in PowerPoint.  As a result, every time you open a PPT or return to the Recorder, SCR will scan your 
PowerPoint to find what's changed.  So do not be surprised if certain actions occur automatically when you return 
to work in SCR; this is just a result of changes you made to your PowerPoint. 

From within SCR, you may use the "File->Open" menu command to open new PowerPoints, or you may open your 
PPTs any other way you are used to.  Once open, SCR will display the presentations name in its title bar, and the 
index of the currently selected slide will be displayed on the faceplate.  You may navigate through your presentation 
either using the forward and back buttons found in SCR, or you may navigate within PowerPoint--after a slight 
pause, SCR will notice and catch up.  Every time you change slides, SCR automatically saves your work for that 
slide.  However, you can return to that slide an undo your changes up until you close SCR. 

As a result, you are always working with one slide from one presentation at a time in SCR.  While there are various 
ways to record or play back across slides, these are never the default.  You are free to re-order your slides within 
PowerPoint; all of your audio and sync information will track appropriately.  However, your audio is not stored 
within PowerPoint (your audio files are stored in a parallel "-audio" directory), so if you copy and paste slides from 
one presentation to another, the audio may not be copied correctly.  In these cases, you can export your audio from 
one slide and then import it into the new slide. 

However, if you change the name of your PowerPoint or do a Save-As, the next time you open SCR, it will 
automatically copy over your previous audio files.  If at any time you want to start over from scratch, you may 
delete the accompanying "-audio" directory. 

**A Brief Note about The Playhead

In SCR, the Playhead, denoted in the middle of the interface by a an orange, vertical, dotted line, indicates where in 
your audio track recording, playback, paste operations and sync operations occur by default.  It is analogous to the 
"cursor" in word processor applications.  However, unlike some other applications, the Playhead is always fixed in 
the center of the interface.  You change the Playhead's relative position in your audio track by using the scrollbar 
along the bottom of SCR.  There is no further cursor, and you cannot change your position just by clicking in the 
waveform like you can in a word processor.

Also note that many operations that default to using the Playhead's position will use the current selection instead, if 
there is one.  While clicking in the waveform won't position the Playhead like a cursor, it will clear any selection 
you may have.
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**Recording 

The most fundamental task that you will perform with SCR is recording your voice.  On a basic level, you just click 
the record button and speak into the microphone.  Just as with any word processing application, when you record, 
by default your new audio will be inserted at your current position (known as the Playhead), and the rest of your 
track will be pushed back, not erased.  You will want to speak and enunciate as clearly as possible, at pace that's not 
too fast and not too slow, all without putting your listeners to sleep!  We generally recommend starting from a 
written script so as to avoid lots of "uhms" and "ahs" or other pauses while you collect your thoughts.  However, 
don't be afraid to revise your script as you begin recording and hear what it sounds like! 

Here's a hitlist of useful information about the recording features in SCR: 

1) By default, when you click record, new audio will be inserted at the Playhead, and existing audio and SyncPoints 
will be pushed back, maintaining their synchronization.  Recording will continue until you click Stop, and all of the 
audio will be contained within the same slide. 
2) If you highlight some audio first, using the mouse, then when you click record, you will REPLACE the selected 
audio.  This can be convenient if you have a phrase or sentence you don't like--just select it, click record, and re-
record it. 
3) If you change slides while recording, without clicking stop, then recording will resume on the new slide, 
wherever you had previously left the Playhead.  Your current slide will save, and if you had previous audio on the 
new slide, there will be an additional pause while the new audio loads.  While saving and loading, SCR is not 
recording!  Just watch the progress meters, and you can record multiple slides consecutively in this manner. 
4) If you hold down the SHIFT key when you click Record, then the new recording will overwrite existing audio, 
rather than pushing it back.  This can be useful if you need to replace some audio in an area where you already have 
a number of SyncPoints. 
5) By contrast, normal recording will keep all SyncPoints attached to the same *audio* they were originally 
attached to--meaning the SyncPoints are attached to the audio, not the time.  As you record normally, your 
SyncPoints will be pushed back along with the audio that they are attached to.  See the section on Syncing for more 
information about working with SyncPoints.
6) There are some helpful shortcuts in the context menu that you can access by right-clicking. 

As a general rule, we recommend that you get the audio for a given slide pretty well worked out before you begin 
syncing animations.  While it's easy to add new audio to a slide with SyncPoints, cutting, pasting, and deleting 
audio in sections that already have SyncPoints can be tricky. 

***Presentation Recording Mode 

There is a special recording mode, not meant for general use, called Presentation Recording Mode.  This mode is 
designed to capture a speech that you do with a real, live presentation.  To engage Presentation Recording Mode, 
hold down the Control (CTRL) key when you click Record.  This will initiate a full screen presentation in 
PowerPoint, and recording will occur in the background.  Additionally, as you change slides, so saving will occur, 
avoiding long gaps in the recording.  There are a few caveats, however: 
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1) Even though there is no saving or loading between slides, there will still be a small, approximately quarter 
second gap in recording when you switch slides.  You can switch slides mid-sentence, but not mid-word. 
2)  All recording occurs on the current slide.  If you hop around slides a lot, the final results could seem incoherent.  
For example, say you've recorded slides 1-5 sequentially, and then return to slide 3 to revisit a certain point.  The 
end of slide 3, which used to transition smoothly into slide 4, will now be interrupted by this new discussion.  When 
you return to it later, it will seem like a non sequitur. 

When you are done, exit your presentation, click Stop, and SCR will now save all of the audio that you have 
recorded 

**Playback 

To listen audio that you have recorded, you just need to click the Play button.  Click Stop when you are done.  By 
default, playback begins at the Playhead and continues until you click stop, or the end of the current slide is 
reached.  Unfortunately, there is currently no way to play back your PowerPoint and audio in sync with each other.  
To see your audio and animations lined up, you will need to Publish your presentation and preview it in StarCast, 
online. 

Here are a number of useful things to know about playing back your audio: 

1) If you select audio with the mouse, only that audio will be played, instead of starting at the Playhead and running 
to the end.  If you have selected audio and then scrolled it off the screen, this may come as a surprise.  You can 
always single click in the audio area (without dragging) to de-select your audio to avoid this.  Using this playback 
facility can help you narrow down the locations that you want to cut, copy, paste, delete, or re-record. 
2) If you move the scrollbar (and thus the Playhead) during playback, playback will automatically jump to wherever 
you let go of the scrollbar.  This can help you quickly locate certain sections of audio. 
3) If you change slides during playback, playback will resume on the new slide (after saving your existing slide and 
loading the new one, if necessary). 
4) If you hold down the Control (CTRL) key and click Play, then when you get to the end of a slide, playback will 
continue on the next slide rather than stopping.  In this manner, you can check your slide-to-slide transitions. 
5) If you start playback from very near the end of a given slide, it will play back from the beginning of that slide 
automatically.  This is helpful right after recording--when you stop recording, and the Playhead is near the end of 
the slide, you can click Play to listen to the whole slide rather than scrolling back to the beginning. 
6) There are some helpful shortcuts that you can access from the context menu by right-clicking. 

**Editing 

Editing behaves like you would expect from most other applications.  Click and drag the mouse to select sections of 
audio, and then you can cut, copy, paste, or delete the selected audio.  These editing functions can be accessed from 
either the "Edit" menu or from the context menu.  SCR has unlimited Undo and Redo capabilities for as long as 
SCR is open.  Once you quit SCR, your Undo and Redo history is lost.  However, you can save as much as you like 
without losing your Undo history.  Note that SCR's Undo and Redo history is completely independent of 
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PowerPoint's.  You may copy and paste audio between slides in the same presentation; however, you can't copy and 
paste between different presentations.  To do that, you need to export your audio and then import it (see Importing 
and Exporting Audio). 

A few helpful things to know about editing:

1) When you click Delete, it will delete whatever audio you have selected.  However, if nothing is selected, it will 
delete all audio for the slide you're on (and that slide only).  Don't forget that you can Undo your edits!  If you 
accidently click Delete with nothing selected, don't panic, just undo your Delete.
2) Copy and Cut operations both copy the selected audio (and only the selected audio; if nothing is selected these 
actions are disabled) to the clipboard.  When the clipboard has something on it, then the paste operation is enabled.
3) By default, Pasting occurs at the playhead and pushes other audio back, in a similar manner to how a word 
processor functions.  
4) However, if you have audio selected when you Paste, then the audio on the clipboard will replace the selected 
audio.
5) Just like occurs during recording, editing operations preserve the sync between SyncPoints and their audio.  
Remember, SyncPoints are attached to a section of audio, not a specific time.  As you Cut/Copy/Paste and Delete 
audio, your SyncPoints will move to maintain this sync.
5) If your selection contains a SyncPoint(s) when you Cut/Copy/Paste, SCR will Cut/Copy/Paste the SyncPoint(s) 
appropriately.
6) Your selection is considered to "contain" a SyncPoint if the SyncPoint's starting edge is contained within the 
SyncPoint.  It is not necessary (although likely more sensible) to include the entire duration of the SyncPoint for 
Cut/Copy/Paste or Delete operations to include the SyncPoint.
7) However, if you edit the audio contained within the boundaries of a SyncPoint, the endpoint of the SyncPoint 
will be adjusted accordingly.  See the section on Syncing for more information about working with SyncPoints.

**Syncing and working with Animations

By using animations in your PowerPoint presentation, you can not only add some visual panache, but also add 
visual cues to help your listeners follow along.  By using the SyncPoint feature in SCR, you can control when your 
animations play back when your presentation is viewed in StarCast.  This allows you to achieve the same affect as 
triggering animations when presenting in front of a live crowd, except with SyncPoints you can edit and perfect 
your timing in an intuitive, visual manner.

In general, StarCast works with the animation model used in PowerPoint 2000, and animations and features 
introduced in PowerPoint XP and newer versions are generally unsupported.  Refer to our online help (click the 
Help button in SCR) for a specific list of supported animations.  However, here are a few guidelines:

1) Only a subset of Entrance animations are supported; Exit and Emphasis animations are not supported.
2) While Exit animations are not supported, you can use the Dim effect to cause elements to disappear.
3) You cannot select text and apply animations.  In PowerPoint 2000, you have to apply the animation to the box 
containing the text.  There is a separate setting for animations to be applied to the text within a box, rather than the 
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animation for the box as a whole.  In StarCast, you must still use this alternate setting even if you have a newer 
version of PowerPoint.
4) Your animations will always play back in StarCast in the same order that you have them in PowerPoint.  You 
cannot use the SyncPoint feature to change the relative order of your animations.
5) All of the bullet points of a text box must animate consecutively--you cannot place other animations in-between 
bullet points from the same text box.  The waveform will be grayed out in-between your synced bullet points as a 
reminder of this fact.  (+)

(+) Unless you are using SCR-Plus, in which case you can achieve this effect by using more than one timeline.  Of 
course, this allows you to have any animations run simultaneously, but it's particularly useful for text due to this 
limitation.  See the section on SCR-Plus for more information. 

In SCR, a "SyncPoint" is a visual indicator of when a given animation will play back and how much time it will 
take for the animation to complete (essentially, the speed of the animation).  Each SynPoint can be resized by 
clicking and dragging on its resizer-box, found at the left and right edges of each SyncPoint in the SyncBar, right 
above the waveform (+).  You can move a SyncPoint by clicking and dragging in-between the resizing-boxes.

(+) This assumes your Zoom level is high enough to see the resizing-boxes.  If you do not see the resizing-boxes, 
click the Zoom-In button.

Unless you specifically move a SyncPoint, it will stay synced to its audio.  As you record new audio or edit your 
audio tack, your SyncPoints will generally stay with their original audio.  This means that your animations will 
continue to play back with the discussion that applies to that animation, and spares you the trouble of having to 
tediously re-sync all your animations every time you change your audio.

*** The Sync Dialog Box and Inserting and Removing SyncPoints

To insert or remove SyncPoints, click on the Sync button, and the Sync Dialog will open.  In the Sync Dialog, you 
will be presented with a list of all of the recognized animations from your PowerPoint, labeled by the type of 
animation ("Fly-In From Left" etc), along with the times at which those animations are currently set to play back (if 
already synced).  You may select any animation that has not yet been synced and click "Sync" to add a new 
SyncPoint.  Select any animation that has already been synced and click "Remove Sync" to remove that SyncPoint.  
When you are done, click Ok.  None of your changes to the SyncPoints are permanent until you click Ok.  Clicking 
Cancel will discard your changes since you opened the Sync Dialog.

A Few Things to know about Inserting SyncPoints:
1) By default, new SyncPoints will be inserted at the PlayHead.
2) If you have audio selected, your new SyncPoint will have the same position and length as the audio selection.
3) However, you cannot use SyncPoints to change the order of your animations in PowerPoint.  If you have already 
synced some of your animations, then if:
  3a) If the Playhead is before a SyncPoint that should logically precede the new SyncPoint, then the new SyncPoint 
will be placed immediately after that SyncPoint.
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  3b) If the Playhead is after a SyncPoint that should logically follow the new SyncPoint, then the new SyncPoint 
will be placed immediately before that SyncPoint.
4) In some cases, there is not enough room in the timeline for the new SyncPoint to be inserted.  For example, if 
you have synced animations 1 and 3, with only 1/2 of a second in-between them, then any attempt to sync 
animations #2 will fail because there is not enough room.
5) You can select multiple un-synced animations and press Sync.  The first animation will be synced using the 
normal rules, and each subsequent animation will be synced at the first available legal time-slot (based on you 
existing SyncPoints and the order of the animations in PowerPoint).
6) When you click on an animation, the element from PowerPoint that is being animated will be selected; this will 
help you keep track of what each animation is.
7) All the changes you make while the Sync Dialog is open are considered to be just one Undo Step.  After clicking 
Ok in the Sync Dialog, if then click Undo, it will return you to the state you were in before opening the Sync 
Dialog.
8) You can also sync the time when Dim actions occur.  Any animation that has a Dim action set will show when it 
is set to Dim, or "N/A" if there is no Dim action.  Dims are ALWAYS synced to the current position of the 
Playhead. (+)

(+) Only available in SCR-Plus

*** Tips for working with SyncPoints

1) You cannot drag SyncPoints over the top of each other.  If you need to move a lot of SyncPoints, or move then 
large distances, take advantage of the Zoom features.  Zoom Out to make large scale adjustments, and then Zoom In 
to make smaller refinements.
2) You can sync your animations during playback for a fast and convenient way of adding your SyncPoints.  Just 
click Sync during playback, and a SyncPoint will be inserted for the next available animation. (+)

(+) Only available in SCR-Plus.

**Embedding Videos 

StarCast allows each slide in a presentation to optionally embed a video.  Embedded videos must be in SWF 
format, and must be playable in Flash version 8 or later.  Support for FLV or other movie formats is currently under 
consideration for future versions of SCR and StarCast Player.

Embedded videos allow you to reuse existing training videos that you may have on DVD or other digital formats.  
First, you will need to convert them into SWF format, using any of a variety of video conversion utilities.  StarCast 
does not provide video conversion except as a paid service.  Contact StarCast Sales for more information at 
sales@starcast.net.  

Here are a few things you need to know about embedding videos:
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1) Videos must be in SWF format.
2) Videos must be playable in Flash version 8 or later.
3) SWF files must have a framerate of 12 fps.  Confusingly, this can be different than the framerate of the actual 
video.  For example, if converting from Quicktime, the original MOV file can have a framerate of 24 (or anything 
else for that matter), so long as the resulting SWF file has a framerate of 12 fps.
4) You must keep in mind that StarCast is an online system, meant to be viewed over the internet.  Currently, it is 
not practical for most users to view DVD or HD quality video in real-time over the internet.  StarCast does not 
impose any particular limits on your file size or bit rate, as we assume that you know your target audience best.  We 
just caution you to keep their bandwidth considerations in mind when preparing videos.

To insert an embedded video, navigate to the desired slide in PowerPoint, and then select "File->Embed Video" 
from SCR's menu (not in PowerPoint's menu).  You will be prompted to select a SWF file; after selecting your 
SWF, you will be presented with some reminders about how embedded videos work.  Click OK, and you will be 
prompted whether you want silence to be inserted into your timeline to account for the length the video will run.  
This is useful if you want to synchronize animations while the video is playing back, or if you wish to record an 
outro in SCR to play after the video.  After selecting Yes or No, SCR will place a Video Placeholder on your PPT 
Slide.  Note that StarCast will always maintain the original aspect ratio (width to height ratio) of the original video.  
While you can freely resize the Video Placeholder, when you return to SCR, the Video Placeholder will snap to the 
correct aspect ratio.

A Few Tips about Embedded Videos:

1) The Video Placeholder represents where your video will appear in the final output when played back in the 
StarCast Player.
2) You can position and resize the Video Placeholder to suit your tastes.
3) Note, however, that the initial size represents the video's native size.  If you find yourself significantly shrinking 
the size, you may be wasting bandwidth for unneeded resolution in the video.
4) You can stack things above and below the Video Placeholder.
5) You can apply an animation to the Video Placeholder, and then give that animation a SyncPoint.  This will 
control the point at which your video begins playing, allowing you to record an introduction to the video in SCR.
6) The audio in the embedded video will play back simultaneously with the audio you record in SCR.  In this 
manner, you can give yourself a music backing track.
7) If you let SCR insert silence when you embed your video, then you can sync animations while the video plays.  
You can use this to create subtitles or other captions, or a great variety of other creative effects.
8) You can use PowerPoints various alignment and layout functions to center your video or align it with other visual 
elements on your slide.

**Publishing 
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In order for your presentation to be viewed, you must Publish it to the StarCast System.  In order to do so, you (or 
your employer or whomever provides you access to StarCast) must have a current, paid up StarCast Account.  Then, 
you must have a StarCast login with Content Manager privileges.  To begin the publishing process, click Publish.

***Selecting Slides to Publish and Editing Slide Titles

The first screen of the Publishing Process shows you the name of the PPT file that will be uploaded, along with its 
size (you are limited to 25 MB for the PPT itself; your audio and embedded videos do not count towards that limit).  
You can also review all of your slide titles, embedded movies, and audio file sizes.  Additionally you can select 
which slides have been updated, in order to speed up the process by not uploading slides that haven't changed.

1) You are only shown up to 10 slides at a time.  Use the forward and back buttons to review all the slides in your 
presentation if there are more than 10 slides.
2) The titles shown initially are the titles as PowerPoint considers them.  In many cases, there is no "Title" element 
on a slide, and these boxes are empty.  The slide titles entered here are what will be seen when this course is viewed 
in StarCast.  These titles will not affect your PowerPoint in any way.
3) Once you have published a presentation once, the slide titles in the PowerPoint are ignored, on the assumption 
that you have labeled them the way you want them.  If you change the titles in the PPT file itself, you will have to 
change them again here.
4) If any of your embedded video files has been moved, renamed, or deleted, it's name will be shown in red.  Click 
"Replace SWF" to find the correct file.  You can also of course use this just to change which video is embedded.
5) The checkbox next to each slide indicates whether or not that slide will be uploaded and converted.  Note, 
however, that your entire PPT file must be uploaded every time.  By unchecking a slide, you can avoid re-uploading 
embedded video and sound files, which can be quite time-consuming though.  Additionally, those slides will not be 
converted, leaving the previous version(s) intact.
6) During Publishing, SCR double checks to make sure that previous versions of unchecked slides exist.  In the case 
that a previous version does not exist, then that slide will be uploaded and converted after all.
7) The checkbox in the upper left, ie not associated with any particular slide, will force all slides to upload or to not 
upload.  You will be prompted whether you want to set all slides to upload (or not) so you won't accidently lose 
your settings.
8) You are limited to a total of 15,000 characters for the aggregate of your slide titles.  This is enough for reasonable 
titles for up to 500 slides (all in one presentation--there is no limit across presentations).

When you are done reviewing your slide titles, embedded videos, and audio files, click "Publish Presentation" at the 
top of the page to log into your StarCast site and select a slot for this presentation.

***Logging into StarCast and Choosing a Slot

After you move past the first screen, you will be presented a list of Globals for your StarCast site.  For an 
explanation of StarCast Globals, please ask your StarCast Site Administrator.  Select the appropriate StarCast 
Global for this presentation, and then enter your user name and password.

Once you have logged in, one of two things will happen:
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1) If you have never published this PPT to this Global before, you will shown a list of Slots to Publish into, or be 
given the choice of creating a new Slot.
2) If you have Published this PPT to this Global before, you will be taken directly to the slot you previously 
Published into.  If you do not wish to use this Slot, you may return to the list of Slots and choose another (or create 
a new one).

If you are creating a new Slot, you must choose a Category, enter a Name and Save before you can Publish.  The 
various fields presented on the Course Abstract page are the same as those found inside the StarCast Administration 
website for the same Course.  You can edit the information here or there, whichever you find convenient.

When you are ready, click Publish and all of the slides that you selected in the initial screen will be uploaded to 
StarCast and converted.  You will be given a progress meter as your PPT, each OGG and embedded SWF file in 
turn is uploaded.  When all your files have finished uploading, you will receive a message that all files have 
uploaded successfully and that your presentation has been scheduled for conversion.  Most presentations are 
converted within a few minutes, and you will receive an email (at the address registered in your StarCast account 
for your user name) when your presentation is ready.  Some small percentage of presentations however can take 
much longer to convert; if you find it is taking more than about 10 minutes for your presentation to convert, you 
may wish to be more careful about converting only the slides that you have changed (by using the checkboxes on 
the Slide Title Review screen).

**Downloading Files 

Any presentations that have been previously Published into your StarCast site can be downloaded by other Content 
Managers.  This is convenient if you work from multiple locations, or on both a desktop and a laptop, or if more 
than one person is working on a given presentation, or just to take another presentation as a starting point for a new 
presentation.

Select "File->Download" from SCR's File menu and log into your StarCast Global just like when you are 
Publishing.  You will be shown a list of Slots that have content available for Download.  After you select a Slot, you 
will be prompted where you want to save the PPT.  Then, the PPT, OGG and embedded SWF videos will be 
downloaded to the appropriate locations.

**Import/Export Audio 

For some specialized uses, you can import and export the audio that you record in SCR.  You can use this either to 
copy audio from one presentation to another, or in if you want to edit or manipulate your audio using another 
program.  One free program that provides a number of powerful effects (such as EQ, Compression, Reverb and the 
like) is Audacity.  See http://audacity.sourceforge.net/ for more information.

To export your audio from a given slide, select "File->Export" from SCR's File menu.  To import audio, select 
"File->Import" from SCR's File menu.
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A few things to know about importing and exporting audio:

1) Audio that is exported is created as 16 bit, 22 Khz WAV files.
2) Audio that is imported must be in the same format.
3) When you import audio, it replaces all audio for that slide.  If you wish to combine your existing audio with the 
imported audio, first copy your existing audio to the clipboard.  Then, after importing, paste your previous audio at 
the appropriate location.

** SCR-Plus

SCR-Plus is a slightly enhanced version of SCR for more advanced users who are professional content developers.  
It is not intended for regular users.  Its main additional features are:

1) Publish across multiple StarCast sites.
2) Allows for multiple SyncPoint timelines, letting you have animations play back simultaneously.
3) Allows Dim-ed animations to have their Dim times synced.

These last two points allow for more complicated animation sequences to be achieved, but at a cost of a fair amount 
of complexity.

For access to SCR-Plus, please contact StarCast Sales at sales@starcast.net.

**Glossary 

Content Manager: 

Context Menu: By right-clicking the mouse, you can open a context menu containing a handful of useful shortcuts. 

Embedded Video: A video created from an external source, like VHS, DVD, a digital camcorder, etc.  These movies 
can be placed on a slide in your presentation for playback within StarCast. 

Playhead: The point at which recording or playback will occur, designated by the vertical orange bar.  Use  the 
scrollbar along the bottom to move the playhead. 

Publishing: The process you go through to make your presentation available online in StarCast. 

Waveform: A visual representation of a sound.  This is displayed in blue on a white background in SCR.
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